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View From The Top
Just a quick word from me this issue. With the 
Cyprus issue out of the way, I believe the bull trend 
will continue due to relative stability in Europe, 
earnings growth in the US and the rotation from 
bonds into equities.

Beta testers wanted for a new service
WatchMyStocks is a new email alert service for investors who 
manage portfolios but don’t have much time to attend to them. It is 
a separate web-based service that will be free to use for ShareScope 
customers. See www.WatchMyStocks.co.uk for more information.

WatchMyStocks has some really neat features such as the ability 
to set a target growth rate for each holding including a margin. A 
channel will be drawn on the graph and you’ll be alerted if your 
holding falls below this channel. WatchMyStocks will also alert you if 
any of your dividends are cut. We’d be really grateful for feedback on 
the service. It takes only a moment to sign-up and several minutes to 
add your holdings and set up alerts. WatchMyStocks is still being tested so please watch out for any 
bugs or erroneous alerts. Please send details to support@watchmystocks.co.uk. Please don’t call the 
ShareScope support team as they are NOT involved with WatchMyStocks.

Some stats from the Customer Survey
Thank you to the 1000 or so customers that took the time to complete our recent customer survey. The 
results are genuinely useful in planning new features and training tools. It is very pleasing to see that 
ShareScope is proving so useful to you. Some selected stats from the survey: 

How would you rate ShareScope? 95% of respondents described ShareScope as very good or excellent; no-
one described ShareScope as unsatisfactory.

Have you ever had any other technical faults with ShareScope? 84% of respondents said they had never or 
rarely had a technical problem. Only 0.3% said they frequently suffered problems.

The point of the last stat is to emphasise that ShareScope is a very stable product – it should work 
seamlessly. Unfortunately, computers being what they are, settings in Windows or your firewall or anti-
virus software can sometimes conspire to cause problems. However, as we have said in previous issues of 
ShareScoop, you should not tolerate problems or slow performance - tell us immediately and we will do 
everything we can to resolve your problem.
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GM’s Column (twitter: @T1mClarke)

Tim Clarke

One thing that surprises me is how many people request data that is already in 
ShareScope. Hopefully, I can address some of these issues in this column.

Generally, I would urge you to use the search feature in ShareScope Help or call us if 
you can’t find particular features or items of data. 

Change list
When you first install ShareScope, there are a number of buttons on the toolbar which enable you to 
change the list of instruments you are looking at: All, Shares, FTSE 100, Investment Trusts, for example. 

There are, however, many more lists 
or subsets of lists that you can display. 
The buttons on the toolbar are just for 
convenience and you can change them if 
you wish. 

To see the lists available, go to the View 
menu and select Change list. The menu on 
the right will appear; click on the required 
list. The list currently selected will have a 
tick next to it.
 
If you want to change the buttons on your 
toolbar to select different lists, look at 
Tutorial 21 – Customising Toolbars in the 
Training Zone on our website 
(www.sharescope.co.uk/trainingzone). 

Fundamentals
Similarly, some customers ask for items of 
fundamental (financial) data like PEG, ROCE 
and Price to Sales Ratio – all of which can 
be found in ShareScope. 

Remember, the List and Details views provided with ShareScope are examples – you can customise them as 
much as you like and save multiple designs using the twelve settings you have for each view. 

If you are not yet familiar with the concept of Settings in ShareScope, I urge you to read Chapter 6 – Settings 
of the User Guide (www.sharescope.co.uk/userguide). 

There are three ways to add further fundamental data items to ShareScope:

List view – Add new columns. Right-click in a List and select Add General column for items like P/E, 
PEG, dividend, yield and EPS. You’ll find options for historical, rolling and forecast values. Select Add 
Results column for ShareScope’s full range of financial metrics.

Details view – Add items to the Results table. You can add items to the Results table, remove them 
and change their position. To add an item, right-click in the Results table and select Add a result to 
table. To remove an item, right-click on the item and select Delete item. To move an item, click and 
drag it to the desired position.

Details view – Add items to Company Ranking tables. Right-click in the Company Ranking box and 
select Add List box item. To move an item, click and drag it to the desired position.

•

•

•
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My data has disappeared!
There are lots of handy features in ShareScope which enable you to filter the data 
you are looking at or hide/show particular items. It is useful to become familiar with 
these – not just because they may help you but because if you inadvertently activate 
them you’ll understand why data has “disappeared” and how to get it back. This is a 
common reason for calls to Support. I’ve covered the main ones below.

New highs/lows
When viewing a list of shares (e.g. FTSE 350), pressing the TAB key (to the left of the Q on your keyboard) 
will filter the list to only those shares whose closing price has achieved a new high. Press TAB again to filter 
for new lows only. Press TAB once more to return to the full list. So, the TAB key cycles through full list – new 
highs – new lows – full list again. Remember, in the ShareScope program title bar (ShareScope Gold), or in 
the List window title bar (Plus & Pro), a description of what you are looking at is displayed. Normally, the 
description might read:

List: FTSE 350 – All Sectors - Table setting 1 

However, if you have pressed the TAB key it might read:

List: FTSE 350 – New Highs - Table setting 1 

or:

List: FTSE 350 – New Lows - Table setting 1 

Show historical shares
Historical shares – that is, those no longer trading – are displayed in green type. Most customers choose to 
hide these shares rather than have them clutter up their lists. This is simple; go to the View menu and look 
for the Show historical shares option. You’ll notice that this has a tick next to it – indicating that the option 
is on. Click on the option to disable it. The tick will be removed and the historical shares will be hidden. 

You will need to bear in mind, however, that if you have historical shares in any of your portfolios then these 
too will be hidden and their values removed from the value of your portfolio. However, you can choose to 
show the historical shares just as easily as you can hide them so we suggest that you do this whenever you 
look at such a portfolio. To show the historical shares, go to the View menu and click on Show historical 
shares once more.

Phil’s Hidden Gems

Phil Tolhurst

Institutional ownership
Another thing the customer survey tells us is how popular 
the Director dealings data is. Personally I use a simplified 
version of this data to show the institutional ownership of 
each share. The example to the left is for Entertainment 
One (ETO). It is particularly effective as a linked component 
of a multi-window layout in ShareScope Plus or Pro.
 

I include the current holdings of major shareholders and the company’s 
directors. Personally I’m not interested in seeing the latest director 
transactions here as I can get these from the event flags I set on my graphs.
 
If you are interested in mimicking this display, right-click in the Directors 
dealings view and click on Select display. The dialog box to the left will be 
displayed: 
 
Choose the options that are shown above and then click on OK.
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Current holdings only
This feature will hide shares that you have held in your portfolio but since sold. Although the profit/loss 
and associated costs of these trades are part of the value of your portfolio, many customers only want to 
see details of their current holdings in the Transaction view. This feature is activated/deactivated by right-
clicking in the Transactions view and selecting Current holdings only. When the option has a tick next to it, 
only your currently held shares will be displayed. Note however that the value of previous holdings will still 
be included in the total value of the portfolio.

When this feature is activated, the description in the window title bar will change to something like this:

Transactions (Current holdings only) – Trans table 1 – Portfolio: SIPP

Latest line only
Another feature of the Transactions view, this hides the individual transactions and displays only the 
summary line (the “Latest line”) for each holding. Again, this feature is activated/deactivated by right-
clicking in the Transactions view and selecting Latest line only.

Hide/show US data and Unit Trusts
This is more of a macro feature but you can opt to 
hide all US data and/or all unit trust data. If you are 
not interested in either of these data sets it is a good 
idea to disable them as it will save space on your hard 
drive and make your update quicker. You can always 
switch them back on in the future if required. 

Go to the Tools menu and click on Options. On 
the Options dialog box click on the General tab. In 
the bottom left corner you will see the Optional 
databases panel. Click in the box for each data set 
that you wish to hide. 

This is NOT an option that can be inadvertently 
activated so these data sets should not suddenly 
disappear. However, the Support team may 
sometimes ask you to disable these data sets in order to investigate a problem so it is worth checking.

Comparing the performance of one instrument with another
We are often asked how you compare the performance of a stock against a benchmark on the graphs in 
ShareScope.

There are two ways of doing this and it helps to understand what information both methods show you.

The option to add an additional instrument to your chart is called Additional Graphs and can be found by 
either right clicking on your chart or selecting the Graph menu. 

When you click on the Add button you are 
presented with a list of options that are divided 
into two groups: Add…  or  Price Relative To….

When you choose Price Relative To… a line 
is drawn on your chart. The line shows the 
performance of the currently selected instrument 
against the chosen benchmark over the time 
period shown on the chart.  The right hand scale 
also changes to show a percentage scale.
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In this example, the red line shows the 
performance of Imperial Tobacco (IMT) 
against the FTSE 100. You can see that, over 
the last 2 years, IMT has out-performed the 
FTSE 100 by a little over 14%.

If we choose the option Add FTSE 100 rather 
than Price relative to FTSE 100 then the 
program attempts to draw the price chart 
of the benchmark, in this case the FTSE 100, 
against the chosen instrument; IMT.  The 
FTSE is currently trading at over 6300, IMT is 
currently trading at around 2390p.  If ShareScope used the same scale to draw these two lines you would 
not see the line for the FTSE 100 it would be way off the top of the chart.  So the program has to rebase the 
FTSE 100 chart so that you can see it on the chart of whatever instrument you are looking at. It does this 
by calculating a ratio between the two prices using the date on the left hand axis and then uses the ratio to 
draw the FTSE 100 chart.
 
In the example to the right you can see the 
FTSE 100 drawn on the same chart as IMT.  
Note: On the far left hand side of the chart 
both lines start at the same point, this is due 
to the rebasing mentioned above.

All that can really be derived from this chart, 
as it is shown, is whether there is a visual 
correlation between the two instruments.  
You can see that recently IMT has been reasonably volatile while the FTSE 100 has been climbing steadily 
for example.  Displaying the charts in this way becomes far more useful if you opt to show one of your two 
axes as a percentage.  

You can do this by selecting the Lines & Text tab in Graph Design. Here 
you can see I have changed the right hand scale to Start at 0% and I have 
set a blue line to draw at 0% as well.  

In this example, you can now see that over 
the two years IMT has risen by just over 20%, 
whereas the FTSE 100 has risen by about 
6%.  The difference between these is the 
Price Relative To… value seen on the first 
screenshot.

You can only show one Price Relative To… 
additional graph however you can show four 
additional graphs in total.  Therefore we can 
also use the above method to add the Share’s 
Sector Index option as well. 
 
On the right, you can see Imperial Tobacco is 
outperforming the FTSE 100 by a considerable 
amount, however it is still underperforming 
the Tobacco sector as a whole. 

Shares are not the only instrument type in 
ShareScope that can display their sector 
performance on their charts. Unit Trusts can 
do this as well.
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In the example below, you can see I have selected a popular unit trust; Invesco Perpetual Income & Growth 
Inc (GTINC).  You can see its performance against the FTSE 100 and against the UK Equity Income sector.

However, the IMA Sector indices are based on Total Returns - A Total Return show the performance of a 
fund assuming all income has been reinvested into the fund.  So you really need to look at the Total Return 
of the fund when comparing it against its Sector Index.

Total Returns by default are turned off in ShareScope to turn them 
on select the Tools menu and then Options.  On the Options dialog 
window select the General tab.  At the bottom left of the General tab 
tick the option for Show total return under Lists.

In the Unit Trust list each Unit Trust will then be followed by an entry for its Total Return. The names of the 
Total Returns are prefixed with TR- and the EPICS are suffixed with –TR.
 
In this example, I have selected the Total 
Return for Invesco Perpetual Income & Growth 
Inc and you can see that on this basis has 
outperformed its sector.

This chart, however, is comparing the Total 
Return of the Fund, against its sector which is 
derived from total return data and also against 
the FTSE 100 index. The FTSE 100 index is not 
calculated using total return data for the FTSE 
100 stocks.
 
In the example to the right, I have added a 
fourth instrument. The purple line shows the 
performance of the FTSE 100 Total Return 
(UKX.TR) for comparison purposes.  You can 
see that the fund is still outperforming this but 
it does provide a better basis for comparison.

Tell A Friend
Don’t forget that you can build up credit on your ShareScope account by recommending a friend. For 
every friend that subscribes to ShareScope, you and they will receive up to two months free data. If 
you pay monthly, we’ll delay your next payment for two months; if you pay annually, we’ll defer your 
renewal for two months. Simply give your account number to your friend and ask them to quote 
it/enter it when they subscribe. Find out more at www.sharescope.co.uk/TAF.
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